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Suunnittelu - Operointilaitteesta riippuvat toiminnot ja piirteet

Layout

Resoluutio

Värit

Kirjasinlaji

Käyttöliittymän suunnittelu kone – tai prosessiläheiseen visualisointiin ja operointiin 
vaatii seuraavat välttämättömät askeleet: 

Rakenteen suunnittelu Ennen varsinaista projektointia on suunniteltava prosessikuvauksen  rakenne. 
Erityisesti seuraaviin kysymyksiin tulee vastata:

• Mitkä tiedot tai prosessiparametrit pitää esittää?
• Paljonko kuvia tarvitaan esitykseen?
• Miten on rakennettava kuvahierarkia?

Paneelityypin valinta Operointipaneelin toiminnat määräävät sekä WinCC flexible projektin esitystavan että
käytössä olevat editorit. Eli kuvat riippuvat operointipaneelista.

Layout WinCC flexiblen kuvan laitenäkymä esittää konfiguroitavaa operointipaneelia. Jos
paneelilla on esimerkiksi funktiopainikkeita eli kiinteitä toimintopainikkeita, niin nämä
näkyvät työpöydällä laitekuvassa. 

Screen resolution Koska eri operointipaneeleilla on erikokoiset näytöt, niin kuvan resoluutio riippuu
käytettävästä paneelista. Kuvan resoluutiota voi muuttaa vain, jos konfiguroi WinCC
flexible Runtime PC-laitetta.

Color depth Kuvaobjekteille voi antaa eri värit. Käytettävien värien määrä riippuu siitä, kuinka 
montaa väriä operointipaneeli tukee. 

Fonts Käytettävät kirjasinlajit riippuvat operointipaneelin tyypistä. Kirjasinten ominaisuudet
riippuvat valitusta kirjasin tyypistä. 

Functions Myös käytettävissä olevat toiminnat riippuvat konfiguroitavasta operointipaneelista. 
Esimerkiksi TP170B ei käytä VBscriptejä (Runtime Scripting ), prosessi-, hälytys- tai 
käyttäjäarkistoja.

Projektin luonti Projektin voi luoda joka STEP7 Managerissa tai WinCC flexible wizardilla.
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SIMATIC operointipaneelien perustoiminnat, esim. TP177 micro

TOIMINTOLAAJUUS

Prosessikuvia    250
Tekstiobjektit      500
Muuttujaa/kuva    20
Kenttää/kuva         20
graaf.objektit 500
Dynaamiset obj. palkit
Muuttujia 250
Salasanasuojaus
Online kielet 5
Kirjasimet WinCC flex
ja symbolikielet
Infotoiminnat
Toistuvat tehtävät

Esimerkki operointipaneelin toimintolaajuudesta – TP177micro
TP177 WinCC flexible Kosketuspaneeli TP177 on rakennettu SIMATIC S7-300/200 ohjauksiin pienille koneille

ja laitoksille. TP177 micro on tarkoitettu vain SIMATIC S7-200:lle. Molempien paneelin
kuvat luodaan WinCC Flexible konfigurointi ohjelmalla.

Toiminnat: Prosessikuvissa
IO-kentät - näyttö- ja syöttökentät prosessimuuttujille
Painikkeet - ohjauskentät: bitin asetus, nollaus, vaihto; kuvakutsut ja muut tehtävät

- ohjauskenttien “tekstit” tekstinä tai grafiikkakuvina
- kiinteät tekstikentät, eri fonttikoot,  max noin 1,5 cm kirjaimin

Vektorigrafiikka - viiva, ympyrä, suorakaide, ellipsi
- grafiikkakuvat, symboliset kentät

Kirjastokuvakkeet - Libraries
Hälytykset - 500 hälytystekstiä,

- hälytystekstin pituus 80 merkkiä
- 8 muuttuja-arvoa hälytyksessä
- rengaspuskuri, 128 merkintää, ei paristopuskuroitu

Asettelut - kontrastin asettelu näytössä
- 5 käyttökieltä on line paneelissa

Projektointi: WinCC flexible
Huomautus: - Tälle paneelityypille TP177micro/ A projektoinnin voi ladata PPI-adapterilla

- Ennen latausta TP177 vaihdetaan siirto-tilaan (Näyttöön teksti: Transfer…)
- File > Transfer settings > projektin osoitus > Download
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WinCC flexible aloitussivu

WinCC flexible
Start Page WinCC flexiblen aloitussivun toiminnot
Avaa - viimeksi käsiteltyjen projektien avaus

- uuden projektin luonti opastusohjelmalla, 
- olemassa olevan projektin avaus
- luo tyhjä projekti, paneelin valinta 
- avaa WinCC flexible projekti

Uuden luonti
On kaksi tapaa luoda uusi projekti:

Käyttäen projekti wizardia

Luodaan ja konfiguroidaan objektit käsin

Project Wizard Opastusohjelma tarjoaa käyttäjälle projektin perustamiseksi askeleittain ohjeet 
konfigurointiasetteluita varten. Opastusohjelmassa on useita vaihtoehtoisia ratkaisuja 
usein tarvittaviin konfiguraatioihin. Tarvittavat objektit (kuvapohjat, kuvanavigointi, 
hälytysnäyttö, systeemikuvat, liityntä, kirjastovalinnat) luodaan automaattisesti tehtyjen 
valintojen mukaisesti. 

Käsin Kaikki objektit voidaan luoda myös käsin ilman „project wizard“-opastusta. Tällöin 
avataan editorit ja lisätään tarvittavat objektit käsin.

--------------------------------------------------------------------------------------------------
Huomautus
STEP7 integrointi Mikäli operointipaneeli on integroitu STEP7 projektiin, voidaan WinCC flexible 

käynnistää suoraan STEP7 projektista.
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Wizardin „The Operator Panel Assistant“ käyttö (1/4)

Wizardin vaiheet (1)
Select project type Wizardin ensimmäisellä valintasivulla  "Select project type“ valitaan projektin tyyppi. 

Kun kyseessä on pieni kone, merkitään "Small machine". Tämän tyyppisessä
projektissa ohjausjärjestelmä liitetään suoraan operointipaneeliin. Wizardilla ei voi
myöhemmin tehdä konfiguraatioon perusmuutoksia. 

HMI device and controller
HMI device Kuvien esimerkissä on valittu operointipaneeliksi "WinCC flexible Runtime"  ja käytetty

resoluutiota 1024x764.

Connection Liityntä operointipaneelin ja logiikan välillä tehdään MPI/DP-liitynnällä. Kun wizardin 
opastusohjelma on päättynyt, tämä liityntä pitää sovittaa laitoksen mukaisesti.  

Controller Ohjauslogiikan tyyppi on SIMATIC S7 300/400.

Next Jatketaan eteenpäin „Next“-painikkeella.
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The Operator Panel Assistant (2/4)

Wizardin vaiheet (2, 3)
Screen template Tällä valintasivulla kootaan yksilöllinen pohjakuva „screen template”. Tätä pohjakuvaa

käytetään kaikien uusien kuvien luomiseen. 
Header Otsikko ei oikeastaan ole pohjakuvan osa. Todellisuudessa wizardi avaa kiinteän 

ikkunan kuvan yläreunaan ja sijoittaa halutut objektit sinne. 
Kiinteän ikkunan etuna on, että se on itsenäinen ikkuna eikä sitä rakenneta uudelleen 
kuvanvaihdon jälkeen. Tämä nopeuttaa kuvien vaihtoa.

Navigation bar Wizardi voi luoda navigointipalkin automaattisesti. Se sallii kuvien navigoinnin samalla
tasolla oikealle/vasemmalle ja hierarkiatasojen välillä ylös/alas.

Alarm window Wizardi luo pohjakuvaan kolme hälytysikkunaa erityisten hälytysluokkien mukaisesti. 
Hälytysikkunoiden näyttöä ohjataan hälytysmerkillä.

Screen navigation Valintasivulla annetaan osakuvien ja alakuvien lukumäärä. Silloin wizardi voi rakentaa 
kuvahierarkian automaattisesti. 

Section screens Osakuvien lukumäärä projektin hierarkian mukaisesti. Systeemikuva luodaan 
myöhemmin.

Detail screens Alakuvien lukumäärä. Niitä voidaan lisätä myöhemmin myös “käsin”.

--------------------------------------------------------------------------------------------------
Ohje Kaikkia wizardilla luotuja objekteja ja valittuja asetteluita voidaan muuttaa myöhemmin.
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The Operator Panel Assistant (3/4)

Wizardin vaiheet (4)

System screens Systeemikuvat sisältävät erilaisia objekteja, jotka esittävät järjestelmän systeemitietoja 
ja suorittavat systeemitoimintoja.

Main screen/Root Valitaan halutaanko pääkuva systeemikuville vai tulevatko kaikki systeemikuvat
näkymään suoraan osakuvien tasolla. 
Kannattaa aktivoida valinta pääkuva.

System screens Valitaan käyttöön järjestelmäkuvat yllä olevan kuvan asetusten mukaisesti.
Ruutu “All system screens” tuo kaikki kuvat yhtäaikaa. Yksittäisvalinnalla voi
halutessaan karsia joitain pois. 

Kuvat tuovat seuraavia toimintoja ja informaatiosivuja:
- kielen vaihto
- runtime pysäytys
- online/offline valinta
- diagnostiikkakuvat
- käyttäjähallinta
- projektitiedot
- järjestelmätiedot
- järjestelmän asettelut.
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The Operator Panel Assistant (4/4)

Valitse yleiskirjasto,
global library

Avaa systeemi kirjastot

Wizardin vaiheet (5,6)

Libraries Kirjastot ovat aiemmin konfiguroitujen kuvien ja projektiobjektien kokoelmia. Ne
laajentavat käytettävissä olevien kuvaobjektien lukumäärää ja lisäävät
konfigurointitehokkuutta, koska kirjaston objekteja voidaan käyttää uudelleen
muuttamatta niitä.

System libraries Valikkosivulla määritellään, mitkä systeemikirjastot avataan projektissa automaattisesti. 
Kolme systeemikirjastoa on kuvan mukaan käytettävissä. 

Global libraries Globaalit eli yleiset kirjastot on talletettu omaan tiedostoonsa. Projekti voi käyttää useita
globaaleja kirjastoja. Sama globaali kirjasto voi olla käytössä useissa projekteissa yhtä
aikaa.

Project information Viimeisessä valikossa voidaan määritellä projektin nimi ja yleistiedot. 

Finish "Finish“-painikkeella lopetetaan syöttö ja wizardi luo operointipaneelin projektiin
annettujen määrittelyiden mukaisesti.
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SIMATIC HMI projektin aseman avaus

Käynnistys WinCC flexible avaa näyttöön Wizardilla luodun tai „Start page“ -sivulta valitun muun 
projektin. 

Työpöytä WinCC flexiblen projektointityöpöydällä näkyvät käyttäjäkohtaiset ikkunat. Lisää
ikkunoita voi avata valikosta

View > "Name of window„. 

Project

Projekti-ikkuna Projekti-ikkunasta päästään käsiksi projektitietoihin. Siinä nähdään kaikki projektin
editoitavissa olevat kohteet, joita valittu operointilaite tukee. Jokaiseen editoriin on 
liitetty symboli, josta voi tunnistaa siihen kuuluvat objektit. 

Laitekohtaiset tiedot Laitekohtaiset tiedot voidaan projektissa suunnitella yksilöllisesti jokaiselle
operointipaneelille. Laitekohtaisia ovat kaikki tiedot ja objektit, jotka on projekti-
ikkunassa järjestetty laitetunnuksen alle kuten kuvat (Screens), muuttujat (Tag), 
reseptit (Recipes) tai arkistot (Historical data). 

Projektikohtaiset Yhteiset tiedot ovat voimassa kaikille operointilaitteille samassa projektissa.
tiedot Ne koskevat kaikkia tietoja ja objekteja, jotka ovat projekti-ikkunassa samalla tasolla

kuin laitetunnus, esimerkiksi kieliasettelut ja versionhallinta:
Language settings, Version management.
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Laiteasettelut – yksityiskohdat laiteversion mukaan

Device settings Kulloinkin käytettävän operointilaitteen laiteasettelut päätetään „Device settings“-
määrittelyissä. Jos käytetään „Project wizard“-suunnitteluapua, niin nämä tiedot
tuodaan automaattisesti.
Tarkistakaa laiteasettelut. Kenttien määrä riippuu laitetyypistä.
„Start screen“valinnalla osoitetaan aloituskuva.
Jos projekti luodaan ilman „Project wizardia“, ovat seuraavat asettelut tarpeellisia.

Laitetyyppi Laitetyyppi valitaan, kun luodaan projekti. Tarvittaessa sen voi muuttaa tässä
valikossa. Tämä asettelu määrää myös kuvien laitenäkymän.

Start screen Aloituskuva on ensimmäinen kuva, joka näytetään Runtime-tilan käynnistyessä. 
Voitte osoittaa oman aloituskuvan jokaiselle operointilaitteelle. Aloituskuvasta
käyttäjä kutsuu muita kuvia. 
Voitte määrätä aloituskuvan myös „Screen navigation“-editorissa. 

Resolution Koska eri operointilaitteilla on erikokoiset näytöt, riippuu kuvan resoluutio valitusta
operointilaitteesta. Voitte muuttaa „Screen resolution“-arvoa vain, kun projektoitte
"WinCC flexible RT" PC-projektia.
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WinCC flexible kielivalinnat

Referenssikieli Editointikieli Runtime kielet

Käyttöliittymän kieli
( WinCC flexible asennus)

Konfigurointikielet
( Windows asennus )

Monikielisyys Toisinaan halutaan käyttää samaa projektia useissa eri maissa tai halutaan tarjota
laitoksen käyttäjälle mahdollisuus valita sopiva useista kielista. 
Tällöin projekti editoidaan useille kielille ja käyttöönottovaiheessa siirretään tarvittavat
kielet operointipaneeliiin. WinCC flexiblessa monikielisyys on sovitettu eri
systeemitasoille. 

Interface language
käyttöliittymän kieli Konfiguroinnin aikana WinCC flexiblen työpöydän valikkotekstit ja välilehtien

määrittelyikkunoiden tekstit esitetään käyttöliittymän kielellä. Käytettävät käyttöliittymän
kielet valitaan WinCC flexiblen asennuksessa. 

Project Kun halutaan tehdä projekti usemmalle kielelle, valitaan useita konfigurointikieliä.
Languages Projektointikielet koskevat koko projektia. On kuitenkin huomattava, että tietty kieli on 

käytettävissä konfigurointikielenä vain, jos PC:n käyttöjärjestelmä tukee kyseistä kieltä. 
Seuraavat asiat on erotettava konfigurointikielissä:

Editing language Aluksi valitaan yksi kielistä editointikieleksi. Kun projekti on luotu valmiiksi tällä kielellä, 
käännetään tekstit muille konfigurointikielille. Nyt vaihdetaan referenssikieleksi kieli, 
jolla projekti tehtiin ensin, ja valitaan seuraava editointikieli.  

Reference language Referenssikieltä käytetään pohjana käännöksissä.
Runtime languages Projektin vaatimusten mukaisesti päätetään, mitkä konfiguroidut kielet siirretään

operointipaneeliin Runtime-käyttökieliksi. Käytettävän operointipaneelin tulee tukea
kyseistä kieltä.
---------------------------------------------------------------------------------------------------

Huomaa Käännös eri editointikielille voidaan tehdä melko tehokkaasti käyttäen automaattista
<Autotranslate> toimintaa. Käännettävien termien sanastoja varten on käytettävissä
sanakirjoja.
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Projektikielien asettaminen

Tehtävänasetus Valitkaa projektille seuraavat konfigurointikielet (poistakaa mahdolliset muut valinnat!):

English ( USA )

Finnish ( Finland )

Suomeksi? Editointi ja referenssikieliksi valitaan aluksi Finnish (Finland). 
---------------------------------------------------------------------------------------------------

Menettelytapa Aluksi valitaan projektointikielet kielivaihtoehtojen listasta:
Project languages Project > Language settings > Project languages.

Vasta tämän jälkeen projektointikielet tulevat konfigurointikielien valikkolistaan.

Editointikieli esitetään vihreällä lihavoidulla tekstillä.

Referenssikieli esitetään vihreällä kursiivilla tekstillä

---------------------------------------------------------------------------------------------------

Ohje Projektointikielet koskevat koko projektia. 
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Runtime-kielien asettaminen

Ladataan
runtime-
käyttöön

Tehtävänasetus Valitkaa Runtime-kieleksi Finnish ( Finland ). 
-------------------------------------------------------------------------------------------------

Runtime-kieli Avataan laitekohtaiset määrittelyt:
Device settings > Languages and Fonts

Editorissa "Languages and Fonts" määrätään, mitä konfigurointikieliä tullaan
käyttämään tietyssä operointipaneelissa. Yhtä aikaa käytettävien kielien lukumäärä
riippuu laitetyypistä. Jotta operointipaneelilla voidaan vaihtaa kielestä toiseen, pitää
konfiguroida tarvittava ohjaustoiminta (painike, valintalista tms.).

Runtime-käynnistyksessä projekti näytetään viimeksi käytössä olleella kielellä.
Ensimmäisessä Runtime-käynnistyksessä projekti aukeaa kielellä, jolla on pienin
järjestysnumero.

Fonts "Languages and Fonts" –editorissa valitaan tekstin kirjasintyyppi kullekin Runtime-
kielelle. Kaikille teksteille käyteään vakiokirjasinlajia, ellei kirjasinlajia erikseen määrätä.
WinCC flexible tarjoaa valittavaksi vain ne kirjasinlajit, joita kyseinen operointipaneeli
tukee.

Useita kieliä? Jos valitaan kaksi kieltä, esim. Finnish ( Finland )  ja English ( USA ), pitää tehdä myös
„kielenvaihto“- painike johonkin kuvaan ja projektoida tekstit kahdelle kielelle.

Talletus Talletetaan tähänastiset asettelut ja muutokset. Kaksoisklikkaa levykeikonia tai valitse
komento Project > Save.
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Kuvanavigoinnin asettelut ( 1 )

Kuvan vaihto projektoidaan suoraan Automaattisesti konfiguroitu navigointivalikko

Jokainen konfiguroitu ohjausnäyttö pitää liittää käyttäjäsovellukseen siten, että käyttäjä
voi kutsua sitä operointipaneelilla Runtime-käytön aikana. 
WinCC flexible tarjoaa seuraavat mahdollisuudet kuvien väliseen runtime –navigointiin:  

Buttons / Jos navigoidaan painikkeiden tai funktionäppäinten avulla, pitää konfiguroida
Function keys "ActivateScreen" – toiminta painikkeen tapahtumaan „Event“ > "Click". 

Kun painiketta painetaan, tapahtuu kuvanvaihto suoraan. 

Navigation bar Kuvien näyttöhierarkia konfiguroidaan „Screen navigation“ –editorilla. Navigointipalkki
luodaan ja konfiguroidaan kuviin automaattisesti. Navigointipalkki sallii navigoinnin
kuvahierarkiassa vasemmalle/oikealle ja ylös/alas.
Etuna on, ettei tarvitse itse keskittyä kuvavaihtojen konfigurointiin. Jos kuvia luodaan
myöhemmin ja ne liitetään hierarkiaan, niin ne integroidaan automaattisesti navigointiin.
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Kuvanavigoinnin asettelut ( 2 )

Navigointipalkin luonti käyttöön/pois

Tavallisesti projektin kuvissa on yhdenmukainen navigointipalkki. Tällöin on järkevää
valita navigointipalkin asetukset esivalinnassa. Avaa projekti-ikkunasta laitekohtainen
toiminta:

Device settings > Navigation control.

Ohje Esivalintaan tehdyt muutokset tulevat voimaan vasta uusiin luotuihin kuviin. 
Ennestään olemassa olleet kuvat säilyvät muuttumatta.

-----------------------------------------------------------------------------------------------
Wizardi Wizardi voi luoda navigointipalkin automaattisesti. Se sallii kuvien navigoinnin

samalla tasolla oikealle/vasemmalle ja hierarkiatasojen välillä ylös/alas. Wizardin
Screen navigation -valintasivulla annetaan osakuvien ja alakuvien lukumäärä. Silloin 
wizardi voi rakentaa kuvahierarkian automaattisesti.  
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Kuvanavigoinnin editori „Screen Navigation“ (1)

Screen navigation Kuvahierarkia esitetään "Screen navigation“-editorin työalueella. Kuvahierarkian voi 
rakentaa tai sitä voi muuttaa graafisesti, kun  kuvat on luotu. Yksittäiset kuvat näytetään 
suorakaiteina, joissa on kuvan nimi. Yhteydet kuvien välillä vastaavat 
navigointimahdollisuuksia Runtime-toiminnan aikana. Erityyppiset yhteydet on merkitty 
viivojen värillä. Mustat viivat osoittavat kuvien väliset hierarkiset yhteydet. Vihreät viivat 
esittävät hierarkiasta riippumattomia suoria valintoja kuvien välillä.

Screen navigation Avataan  "Screen navigation" editori
Device settings > Screen Navigation

Unused screens Käyttämättömien kuvien listassa on kuvat, joita ei ole vielä sidottu kuvahierarkiaan.

Aloitus: Start screen Aluksi työalue on tyhjä. Hierarkia aloitetaan ylimmästä eli aloituskuvasta. Valitse "Start 
screen“ käyttämättömien kuvien listasta ja vedä se työalueelle. 

Lisää kuvat Merkitse "Unused screens“-taulukosta vuorotellen kaikki kuvat ja vedä ne editoriin. 
Seuraa haluttua järjestystä, koska se määrää navigointipalkin painikkeiden
nimeämisen.
Jos talletat kuvan edellisen kuvan viereen tai sen alle työalueella, lisätty kuva tulee
edellisen alakuvaksi. Kun vedät kuvaa, saat näkyviin mallin mikä kertoo uuden kuvan 
sijoituspaikan kuvahierarkiassa.

Nimet Kuvahierarkian rakenteeseen kuuluu, että navigointipalkki lisätään automaattisesti joka 
kuvaan. Jos kuvalla on alikuvia tai oheiskuvia, niin jokainen lisäpainike konfiguroidaan 
automaattisesti hyppykomennolla seuraavaan kuvaan. Painikkeet saavat tekstiksi 
kohdekuvan nimen. 
Siksi on tärkeätä ensin muuttaa kuville lopulliset nimet. Jos kuvan nimeä vaihtaa 
myöhemmin, se ei muuutu painikkeeseen.
-------------------------------------------------------------------------------------------------

Ohje "Unused screens" -taulukkoon voidaan lisätä uusi kuva painikkeella "Add to screen 
navigation“.
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Direct Connections – suorat kutsut kuvasta toiseen

Direct connections Toiminta: Vedetään „Huolto/Maintenance“- kuvan liityntänurkasta vihreä nuoli keskelle 
„Diagnostics“-kuvaa ja klikkaa sitä kerran. Liityntänurkan suorien linkkien lukumäärä
kasvaa yhdellä (1). „Huolto“-kuvaan on ilmestyy lisää painikkeita tarvittaessa kuvan 
yläreunaan. 

Luotujen suorien yhteyksien tiedot voi tarkistaa „ Huolto/Maintenance“- kuvan 
ominaisuusikkunasta Properties- välilehdeltä. „Huolto“-kuvaan on ilmestynyt lisää
painikkeita kuvan yläreunaan. 

Kun klikkaa navigointipalkin painiketta, sen ominaisuusikkuna aukeaa: “Screen object _ 
nro”. Tekstin voi korjata kuvakkeeseen sopivaksi.

Panning tool Kohdistusikkunan avulla voidaan muuttaa työalueella näkyvissä olevaa aluetta.
Lisätoiminnat
Rotate/pyöritä Rakennenäkymää voi pyörittää ja vaihtaa vaakasuoran ja pystysuoran esityksen välillä.

Show/hide Rakennetta voi yksinkertaistaa näyttämällä tai piilottamalla alakuvia. 
Klikkaa hiirellä kuvaa tarkoittavan suorakaiteen + tai – ruutua. 

-------------------------------------------------------------------------------------------------
Sulje editorit Talleta projekti ja sulje navigointieditorit ennen käännöstä. 

Käännös Koko projekti käännetään toiminnalla 
Project > Compile > Rebuild all

”Output”- ikkunasta tarkistetaan,  ettei tullut virheitä. 
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Liitäntöjen projektointi

Ohjauksen
valinta

Connections Tässä editorissa projektoidaan ohjausliitynnät.
„Name“ vapaamuotoinen tunnusnimi liitynnälle.
„Active“ aktivoidaan kyseinen liityntä käyttöön.
„Online“ ohjaus toimii online tai voidaan erottaa kuvien testin ajaksi offline.
„Communication and driver“-sarakkeessa valitaan ajuriksi SIMATIC S7 300/400. 
„Station“ STEP 7 projektin PLC:n osoitus

SIMATIC S7 Operointipaneelit voidaan liittää SIMATIC S7–automaatiolaitteisiin useiden eri
kommunikointiverkkojen kautta. Käytettävä kommunikointiverkko riippuu S7:aan 
asennetusta kortista ja operointipaneelin tyypistä. Seuraavat kommunikointiverkot
ovat mahdollisia:

Interface

MPI (Multi Point Interface)

PROFIBUS (Process Field Bus)

Ethernet

PLC Device Liityntä SIMATIC S7–ohjaukseen on mahdollista CPU:n MPI-/ PROFIBUS-/Ethernet 
– liitäntäpisteen kautta. Jos automaatiolaitteella ei  ole integroitua Ethernet -
liitäntäpistettä, käytetään kommunikaatioprosessoria (CP).

Huomaa
STEP7 integrointi Jos liitynnän projektointi tehdään STEP 7:n HW-Konfiguraatiossa, niin projektoidut

liityntäparametrit otetaan automaattisesti käyttöön integroidussa WinCC flexible
projektissa.
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Projektin käännös ja konsistenssin tarkastus

„Output“- window
Tarkista onko varoituksia 
tai virheilmoituksia

Tarkastus Projektointivirheiden löytämiseksi, käynnistäkää konsistenssin tarkastus valikkokäskyllä
Compiler Project > Compiler > Check Consistency

tai vastaavalla kuvakepaletin symbolilla. 
Jos projektissa on tehty paljon muutoksia, kannattaa ajaa koko käännös uudelleen:

Project > Compiler > Rebuild all

Output window Tulostusikkunassa luetellaan kaikki projektin virheelliset kohdat. 
Käytössä on kolme erilaista virheluokkaa:

Notes Ohjeet
Mahdollisesti projektin loogiset lukitukset eivät ole kunnossa tai ne puuttuvat. Käännös
suoritetaan läpi täydellisesti.

Warnings Varoitukset

Projektissa on virheitä, jotka voivat johtaa epätäydellisiin näyttöihin operointilaitteella. 
Käännös suoritetaan läpi täydellisesti.

Errors Virheet
Virheet on poistettava, jotta teidän tiedot voitaisiin siirtää täydellisesti operointilaitteelle. 
Virhenumero auttaa teitä virhetyypin tunnistamisessa.

Help Voitte pyytää apua yksittäisiin ilmoituksiin, kun viette hiiren osoittimen vastaavalle
ilmoitusriville ja painatte <F1>-painiketta.

Hyppy Kaksoisklikatkaa tulostusikkunassa ilmoitusriviä, jotta pääsette projektissa siihen
kohtaan, joka aiheutti virheilmoituksen.
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Projektin siirto, operointipaneelin asettelut (1)

Control Panel >>  
Tarkista osoitteet 
projektin mukaisiksi! 

Käännös Kun projektointi on valmis ja konsistenssin tarkastus on mennyt läpi virheettä, 
generoikaa projekti kerran kokonaan uudelleen valikkokäskyllä

Compiler Project > Compiler > rebuild all. 
Käännöksessä syntyy runtime-tiedosto, jolla on sama nimi kuin projektilla, mutta
tiedostopäätteenä on *.fwx.

Siirto
Transfer Kun generointi on onnistunut, siirtäkää käännetty projektitiedosto operointilaitteelle, 

jossa projektin kuuluu toimia.
Kun käynnistätte siirron projektilla, jonka sen hetkistä versiota ei vielä ole käännetty, 
tapahtuu ennen siirtoa automaattinen käännös.

Operointilaite
TP 170 B Siirtoa varten pitää operointipaneelin olla siirtotilassa / "Transfer mode„.

Operointipaneeli TP170B voidaan kytkeä siirtotilaan kahdella tavalla:
Transfer Settings Channel 1/2 – siirtokanava on esim. MPI/DP tai sarjaliikenne

Remote Control:
Kun operointipaneelin „Control Panel“-konfiguroinnissa on aktivoitu etäsiirto “Remote
Control„, vaihtaa paneeli automaattisesti siirtotilaan WinCC Flexible 
konfigurointiohjelman siirtokomennolla.

Käsin vaihto siirtotilaan:

Käynnistäkää operointilaite uudelleen ja kutsukaa käynnistyksen alussa „Startmenu“-
kuvasta „Transfer“ toimintaa.

S7-Transfer Settings Operointipaneelille on annettava projektissa määritelty laiteosoite ja tarkistettava
väyläparametrit.

TARKISTA Tarkista kurssilaitteiden osoitteet S7-projektista, esimerkeissä käytetään TP170B 
paneelille DP=10, nopeus 1,5 Mbits/s, HSA=126, profiili DP.  
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Projektin siirto, asettelut WinCC flexible ohjelmassa (2)

Anna osoite:
Station address  _____

Transfer Settings Jokaiselle projektissa olevalle operointilaitteelle voi käyttää yksilöllisiä siirtoasetteluita.
Transfer Siirtotoiminnalla siirretään käännetty projektitiedosto jokaiselle projektin

operointilaitteelle, jolle on aktivoitu siirtoruutu.
Myös silloin kun valikosta käynnistetään siirto vain yhdelle laitteelle, pitää siirtoruutu
olla aktivoitu. 

Modus, siirtotapa Tässä valitaan sarjaliikennekaapeli, verkko tai väylä, jonka kautta siirto tapahtuu. 
Tarkistettava operointipaneelin osoite.

Talletuspaikka
Transfer in Käännetty projektitiedosto voidaan siirtää operointipaneelin Flash-muistiin tai vain testiä

varten RAM-muistiin.
Delta - Transfer Osittaissiirrossa siirretään uudelleen vain muuttuneet projektitiedot, jos

operointipaneelissa on jo projektitiedoston aiempi versio.
Jos operointilaitteena on PC, siirretään aina koko tiedosto.

Overwrite Kun aktivoidaan vastaavat tarkastusruudut, niin siirrossa ylikirjoitetaan salasanalistat
sekä reseptitietueet, jotka ovat ennestään operointilaitteen muistissa. 
Tämä voidaan estää, kun deaktivoidaan vastaavat tarkastusruudut (ruksi pois).

Backtransfer Projektitiedoston takaisin luku edellyttää, että operointilaitteella on erillinen Flash 
muistimoduuli.
Katso varmuuskopioinnista tarkemmin ProSave ja BackUp toiminnat (Esim. On line
Help).
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